Exercise 11 – AGCHEM

BASINS/HSPF Application Steps

Questions addressed in this exercise:
1) Where can I view nutrient modeling output from AGCHEM?
2) How do I interpret output files and summary reports?
3) What are some important nutrient loss processes with respect to agricultural land?
4) Which parameters are important for modeling plant uptake?
5) What are some important nutrient sources with respect to agricultural land?
6) Which parameters are important for modeling mineralization?
7) How can I adjust the amount of atmospheric deposition in my model?

Pesticide, nitrogen, and phosphorus compounds are important to agricultural production. Prediction of their removal from fields is necessary for wise management of both land and water resources. HSPF can be used to predict loads from different land uses given various land management practices. The agri-chemical (AGCHEM) sections of the PERLND module of HSPF simulate detailed nutrient and pesticide processes, both biological and chemical, and the movement of any nonreactive tracer in a land segment. These chemicals can also be simulated in module section PQUAL, but in a simplified manner. The dynamic and continuous processes that affect the storages and outflow of pesticides and nutrients from fertilized fields should often be simulated in detail to fully analyze agricultural runoff. This is especially important if there is a need to evaluate impacts of chemical and nutrient applications, nutrient management alternatives, and other agricultural or forestry practices. The AGCHEM section allows representation of a complete nutrient/chemical balance approach as the foundation for modeling soil processes. If the situation does not require full representation of these processes nor of nutrient balances, or if sufficient data are not available, the PQUAL subroutines can be used (HSPF Manual, 2001).

In modeling nutrients with AGCHEM, there are two important components of the nutrient balance that must be considered: (1) sources such as mineralization, atmospheric deposition, and fertilizer application, and (2) losses such as plant uptake and immobilization. These sources and losses are represented in terms of ‘plant available’ nutrients, which are primarily the inorganic forms, i.e. NO₃, NH₃, PO₄.

In this exercise, we will gain a better understanding of how AGCHEM works by adjusting key parameters, running various scenario simulations, and ascertaining the effects of our adjustments by examining output files, plots, and summary reports.
A. AGCHEM Output and Reports

QUESTIONS ANSWERED:
1) Where can I view nutrient modeling output from AGCHEM?
2) How do I interpret output files and summary reports?

1. Using Windows Explorer or My Computer, navigate to c:\basins\modelout\agchem. Double click “wb_agchm2.out.” View the file in WordPad or Notepad. Your screen should look like the following:

```
1
PERIOD LAND SEGMENT NO. 310 HIGH-TILL CROP REPORT FOR PRINTOUT 1
*** ATEM ***
STATE VARIABLES
AIR TEMPERATURES (deg F) GAGE SEGMENT
90.0 90.0
*** WATER ***
STATE VARIABLES PERS CIPS DIPS UZS UZS IFWS L2S AOWS GWSS
IN IN IN IN IN IN IN IN IN
0.292 0.000 0.000 0.026 0.020 0.000 0.000 0.000
FLUXES
EXTNL INFLWS & OUTFWS MOISTURE<-----OUTFLWS TO STREAM<----->GUN DEEP PERC
SUPT SUBR IFWU AOWU PERO IOWI
IN IN IN IN IN IN
36.200 1.516 3.415 3.238 8.160 0.000
```

2. Look through the file. Try to determine the answers to the following questions:

a. How much total Nitrogen was applied to PERLND 310 in 1986?
b. What were the components of this application?
c. How much total nitrogen plant uptake was there in PERLND 310?
d. How much nitrogen plant uptake was there in the upper zone?
e. How much total nitrogen is stored in the soil in PERLND 310 at the end of 1996?
f. How much mineralization of nitrogen occurred in 1986 in PERLND 310?
g. Which soil layer had the largest amount of mineralized nitrogen?

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
<th>Answer Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>133.16 lbs/ac</td>
<td>NITR → Applications: Nitrogen All Forms</td>
</tr>
<tr>
<td>B</td>
<td>Ammonia (64.34 lbs/ac) Nitrate (21.34 lbs/ac) Organic N (47.48 lbs/ac)</td>
<td>NITR → Applications: Ammonia, Nitrate, Organic N</td>
</tr>
<tr>
<td>C</td>
<td>106.83 lbs/ac</td>
<td>NITR → State Variables → Storages by Layer → Totals: Plant N</td>
</tr>
<tr>
<td>D</td>
<td>80.16 lbs/ac</td>
<td>NITR → State Variables → Storages by Layer → Upper Principal: Plant N</td>
</tr>
</tbody>
</table>
Next, we will open the summary reports generated during the simulation to verify the results shown in the standard output and to illustrate the difference in the output formats. The summary reports include the nitrogen and phosphorus fluxes for each PERLND for each year, as well as the average fluxes for the simulation period. The reports also include simulation results for mineralization, plant uptake by soil zone, runoff by layer and type (NH₃, NO₃, etc.), and nitrification.

3. Using My Computer or Windows Explorer, navigate to c:\basins\modelout\agchem. Right click “PU_300.rpt” and select Open With → WordPad. The Plant Uptake report will open.

4. Look through this report. Notice that the simulated nitrogen plant uptake for the upper zone in 1986 is 79.015 lbs/acre. This is the same value that was found in the output file (see question D in step 2).

5. Close PU_300.rpt.

6. Open the other reports (all the *.rpt files). Try to find the answers to the questions in
BASINS/HSPF Training

Exercises

Recall from the AGCHEM lecture that when modeling nutrients, there are two main components of nutrient balances: sources/inputs (adding nutrients to the system) and losses/outputs (immobilizing or taking nutrients from the system). Key nutrient source processes for agricultural land include nutrient applications of fertilizers and manure, atmospheric deposition, as well as mineralization of soil organic nutrients. Key removal processes for agricultural land include plant uptake and (to a lesser extent) immobilization. In the following sections, you will become more familiar with the sensitivity of parameter inputs on nutrient fluxes by adjusting key parameters, running the model, and examining output to determine the effects on the simulation.

B. Nutrient Losses (Outputs)

QUESTIONS ANSWERED:
3) What are some important nutrient loss processes with respect to agricultural land?
4) Which parameters are important for modeling plant uptake?

Plant Uptake

Plant uptake is a process by which chemicals in the soil can be extracted from the pool of inorganic nutrients available for runoff and leaching. Because plants can take up nitrogen and phosphorus in large quantities and significantly affect processes such as runoff and leaching, it is important to effectively model plant uptake. In the following steps, we will examine the effects of adjusting key plant uptake parameters.

1. From the Start menu under Programs, select BASINS and then WinHSPF.

2. Navigate to c:\basins\modelout\agchem and select “wb_agchm.uci”

Before we make parameter adjustments, we will look at plant uptake plots for both nitrogen and phosphorus in GenScn.

Note: The output for this model has already been specified. You can view the output locations by clicking the Output Manager button, and then clicking the button beside “Other.” The Output Location list will look similar to the following:
Notice the constituents listed for PERLND 310 and PERLND 311. These constituents represent the amounts of nitrogen and phosphorus in the soil by layer. For example, NITR:UN is the amount of nitrogen in the upper layer of soil. For these constituents, there are several output options. Each constituent has a set of several subscripts ([1,1], [2,1]... [8,1]), representing the alternative forms of nitrogen. The HSPF Manual \textit{(c:\basins\docs\hspf.chm)} lists the subscripts and explains what they represent for each section (NITR and PHOS). We selected NITR:SN(5,1), NITR:UN(5,1), NITR:LN(5,1), and NITR:TN(5,1) for the nitrogen plant uptake variables and PHOS:SP(4,1), PHOS:UP(4,1), PHOS:LP(4,1), and PHOS:TP(4,1) for phosphorus plant uptake variables. The constituents are named according to the following convention:

<table>
<thead>
<tr>
<th>Name</th>
<th>Constituent</th>
</tr>
</thead>
<tbody>
<tr>
<td>SN</td>
<td>Nitrogen in surface layer storage (lb/ac)</td>
</tr>
<tr>
<td>UN</td>
<td>Nitrogen in upper layer principal storage (lb/ac)</td>
</tr>
<tr>
<td>LN</td>
<td>Nitrogen in lower layer storage (lb/ac)</td>
</tr>
<tr>
<td>TN</td>
<td>Total nitrogen in soil</td>
</tr>
<tr>
<td>SP</td>
<td>Phosphorus in surface layer storage (lb/ac)</td>
</tr>
<tr>
<td>UP</td>
<td>Phosphorus in upper layer principal storage (lb/ac)</td>
</tr>
<tr>
<td>LP</td>
<td>Phosphorus in lower layer storage (lb/ac)</td>
</tr>
<tr>
<td>TP</td>
<td>Total nitrogen in soil</td>
</tr>
</tbody>
</table>

3. Close the Output Manager if you opened it.

4. Click \( \text{(Run HSPF)} \).

5. Click SAVE/RUN.

6. Click \( \text{(View Output through GenScn)} \).

7. Click the “HSPF Output” tab and select \textit{c:\basins\modelout\wb\ag.wdm}. Click OK. GenScn will open.

8. In the “Locations” frame, select “PER 310.”
9. In the “Scenarios” frame, select “WB_AGCHM.”

10. Click the “Add to time series list” button. The “Time Series” list should look like the following:

11. Hold down the SHIFT key and click on the timeseries corresponding to SN, UN, LN, and TN. These contain values for plant nitrogen uptake for the surface, upper layer, lower layer, and total uptake, respectively.
12. Click the “Generate Graphs” button.

13. Click GENERATE. Your plot should look similar to the following:

![Graph Image]

14. Toggle to GenScn (don’t close the above plot).

15. Hold down the SHIFT key and click on the times series corresponding to SP, UP, LP, and TP. These contain values for plant phosphorus uptake for the surface, upper layer, lower layer, and total uptake, respectively.

16. Click the “Generate Graphs” button.

17. Click GENERATE. Your plot should look similar to the following:
Notice that plant nitrogen and phosphorus concentrations are reset to zero at the beginning of each year. This is to represent crop-removal as a result of harvest practices, e.g., removal of corn stalks for silage after harvest. If you want, you can change this to a more reasonable harvest time (for example, October 15) in the SPECIAL ACTIONS block and assess the impacts on the uptake curves. Since plant uptake is a state variable, defined as the nutrient amount taken up by the plants from each soil layer, it will continually increase until some type of intervention, such as harvest operations, resets this value so that it will begin to accumulate as the subsequent year crop begins to grow again. There are more detailed nitrogen cycling options within the NITR module for the return of forest and crop residues and litter to the soil (See the HSPF Manual), but these are not activated in this simple example.

Notice that for both nitrogen and phosphorus, the surface uptake (SN and SP, respectively) is essentially zero. This is because there is very little moisture in the surface soil layer except during runoff events, and plant uptake is derived only from the soluble inorganic forms; for the surface layer these forms are essentially zero except during storm events. Thus, plant uptake occurs primarily from the upper zone and lower zone, which retain moisture and soluble nutrients. These constituents can also be extracted from groundwater (the model allows this pathway), but for most agricultural conditions, the rates that control this are usually set to zero—most crops will not survive under extended saturated soil conditions.

18. Close the plot(s) and the “Graph” window.

19. Exit GenScn and return to WinHSPF.

To help you understand the impact plant uptake rates have on the model, we will double the plant uptake rates for both nitrogen and phosphorus for each layer and then run the model and plot the results.

Before we adjust the uptake rates, we will create another project file for this scenario (doubling the plant uptake rates for each layer). After we have run the scenario, we will
return to our original input file (\textit{wb\_agchm.uci}) to run other scenarios.

20. From the \textbf{File} menu, select \textbf{Save As}.

21. Enter “ag\_uptak” as the “New Project” name.

22. Click OK.

23. Click \textbf{(Input Data Editor)}.

24. \textbf{Double click} \textit{PERLND} $\rightarrow$ \textit{NITR} $\rightarrow$ \textit{MON-NITUPT}. The following table will appear:

\begin{center}
\begin{tabular}{|c|c|c|c|c|c|c|c|c|c|c|c|c|}
\hline
\hline
310 & High-till crop & 0 & 0 & 0 & 0.96 & 1.20 & 1.38 & 1.38 & 1.38 & 1.38 & 1.38 & 1.38 & 1.38 \\
311 & Low-till crop & 0 & 0 & 0 & 0.18 & 0.32 & 0.36 & 0.36 & 0.36 & 0.36 & 0.36 & 0.36 & 0.36 \\
\hline
\end{tabular}
\end{center}

\textbf{Note:} Notice the “Occurrence” menu at the top of the screen. Occurrences 1, 2, and 3 correspond to the surface, upper, and lower layers respectively. We will double the uptake rates for each layer (occurrence).

\textbf{Note:} We are entering monthly values for plant uptake because the uptake rates vary greatly by month (e.g., little or no uptake occurs during winter months).

25. Make sure the “Occurrence” is “1” (for the surface layer). Change the monthly values for \textit{PERLND} 310 and \textit{PERLND} 311 to the following:

\begin{center}
\begin{tabular}{|c|c|c|c|c|c|c|c|c|c|c|c|c|c|}
\hline
\hline
310 & High-till crop & 0 & 0 & 0 & 2.18 & 5.06 & 11.6 & 20.2 & 20.2 & 20.2 & 17.3 & 11.6 & 1.46 \\
311 & Low-till crop & 0 & 0 & 0 & 0.56 & 1.34 & 3.06 & 5.38 & 5.38 & 4.6 & 0.06 & 0 & 0 \\
\hline
\end{tabular}
\end{center}

26. Click APPLY.

27. From the “Occurrence” list, select “2” (for the upper layer). Change the values to the following:

\begin{center}
\begin{tabular}{|c|c|c|c|c|c|c|c|c|c|c|c|c|c|}
\hline
\hline
310 & High-till crop & 0 & 0 & 0 & 2.18 & 5.06 & 11.6 & 20.2 & 20.2 & 20.2 & 17.3 & 11.6 & 1.46 \\
311 & Low-till crop & 0 & 0 & 0 & 0.56 & 1.34 & 3.06 & 5.38 & 5.38 & 4.6 & 0.06 & 0 & 0 \\
\hline
\end{tabular}
\end{center}

28. Click APPLY.

29. From the “Occurrence” list, select “3” (for the lower layer). Change the values to the
following:

<table>
<thead>
<tr>
<th>OpNum</th>
<th>Description</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>310</td>
<td>High-till crop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>7.22</td>
<td>11.6</td>
<td>11.6</td>
<td>9.38</td>
<td>6.52</td>
<td>0.72</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>311</td>
<td>Low-till crop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1.38</td>
<td>2.9</td>
<td>2.9</td>
<td>2.9</td>
<td>2.9</td>
<td>2.9</td>
<td>2.9</td>
<td>2.9</td>
<td>2.9</td>
</tr>
</tbody>
</table>

30. Click APPLY.
31. Click OK.
32. **Double click** NITR to contract the list.
33. **Double click** PHOS $\rightarrow$ MON-PHOSUPT.
34. Make sure the “Occurrence” is “1.” Change the monthly values for PERLND 310 and PERLND 311 to the following:

<table>
<thead>
<tr>
<th>OpNum</th>
<th>Description</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>310</td>
<td>High-till crop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>6.2</td>
<td>11.8</td>
<td>11.8</td>
<td>13.8</td>
<td>16.6</td>
<td>16.6</td>
<td>13.8</td>
<td>16.6</td>
<td>13.8</td>
</tr>
<tr>
<td>311</td>
<td>Low-till crop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1.2</td>
<td>4.6</td>
<td>7.2</td>
<td>5.8</td>
<td>5.2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

35. Click APPLY.
36. From the “Occurrence” list, select “2.” Change the values to the following:

<table>
<thead>
<tr>
<th>OpNum</th>
<th>Description</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>310</td>
<td>High-till crop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>8.4</td>
<td>11.8</td>
<td>14.6</td>
<td>16.6</td>
<td>18</td>
<td>18</td>
<td>13.2</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>311</td>
<td>Low-till crop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>7.8</td>
<td>11</td>
<td>13.6</td>
<td>15.6</td>
<td>17</td>
<td>17</td>
<td>0.2</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

37. Click APPLY.
38. From the “Occurrence” list, select “3.” Change the values to the following:

<table>
<thead>
<tr>
<th>OpNum</th>
<th>Description</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>310</td>
<td>High-till crop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1.2</td>
<td>4.8</td>
<td>7.6</td>
<td>7.6</td>
<td>6.2</td>
<td>5.6</td>
<td>3.4</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>311</td>
<td>Low-till crop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>5.8</td>
<td>11</td>
<td>13</td>
<td>15.6</td>
<td>15.6</td>
<td>15.6</td>
<td>0.2</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

39. Click APPLY.
40. Click OK.
41. Click CLOSE.
42. Following steps 4 -17 in this section, run the model and graph the plant uptake curves for nitrogen and phosphorus.
Note: When GenScn opens, you will see that there are several options in the “Scenarios” frame. To view the results of the scenario you just simulated (doubled plant uptake rates), select “PER 310” in the “Locations” frame, and “AG_UPTAK” in the “Scenarios” frame. Graph the timeseries for nitrogen and phosphorus.

Your plots should look similar to the following:

The plots indicate that doubling the plant uptake rate increased the plant storage of both nitrogen and phosphorus. To better examine the differences between these plots and those you created in the previous simulation, we will plot the results from both simulations.
BASINS/HSPF Training

Exercises

11-12

together.

43. Toggle to GenScn.

44. In the “Locations” frame, make sure “PER 310” is selected.

45. In the “Scenarios” frame, select “WB_AGCHM” and “AG_UPTAK.”

46. Click the “Add to time series list” button.

47. Select the timeseries that correspond to WB_AGCHM and AG_UPTAK for SN, UN, LN, and TN (you will select a total of eight timeseries):

48. Click (Generate Graphs).

49. Click GENERATE. Your plot should look similar to the following:

50. Select the timeseries that correspond to WB_AGCHM and AG_UPTAK for SP, UP,
LP, and TP (you will select a total of eight timeseries):

51. Click \(\text{Generate Graphs}\).

52. Click GENERATE. Your plot should look similar to the following:

Examine the plots. Doubling the uptake rates appears to have had a more pronounced affect on the phosphorus storage than the nitrogen storage, even considering the large difference in the total uptake, with nitrogen approaching 110 lb/ac and phosphorus about 20 lb/ac. Plant uptake is controlled by the amount of inorganic nutrient in soluble form available to the plant in each soil layer. Since nitrogen must undergo other processes (e.g. nitrification, denitrification, volatilization) controlling its availability to the plant, actual plant uptake may have been limited by the available storage. Examine the AGCHEM output to see if this is a plausible explanation.

53. Close all plots, the “Graph” window, and GenScn. Return to WinHSPF.

**Immobilization**

Immobilization is the conversion of inorganic nutrients (NH3, NO3, PO4) to organic material. Most organic material is bound tightly to soil, and therefore relatively immobile.
Because immobilization does not significantly affect our simulation, we will not adjust any parameters related to this process in this exercise. In your own applications, you should look at the KIMNI and KIMAM for nitrogen and KIMP for phosphorus, to assess the potential impacts of immobilization on the nutrient balances. It will tend to reduce inorganic nutrient concentrations and may be used to reduce this form in the runoff components.

C. Nutrient Sources (Inputs)

QUESTIONS ANSWERED:
5) What are some important nutrient sources with respect to agricultural land?
6) Which parameters are important for modeling mineralization?
7) How can I adjust the amount of atmospheric deposition in my model?

Mineralization

Mineralization is the process in which organic matter is converted to inorganic products. For nitrogen, it is also often called ammonification. It is important in modeling nutrients because when organic matter is broken down into inorganic components, nutrients become available for plant uptake, runoff and leaching.

In this section, we will adjust the mineralization rates and assess the impacts by running the scenario and plotting the results. We will create a new project for this scenario based on our original \textit{wb\_agchm.uci} file.

1. In WinHSPF, from the \textbf{File} menu, select \textbf{Open}. The following window will appear:

2. Click \textbf{OK}.

3. Navigate to \texttt{c:\basins\modelout\agchem}. Select “\texttt{wb\_agchm.uci}” and click \textbf{OPEN}.

4. From the \textbf{File} menu, select \textbf{Save As}.

5. Enter “ag\_min” as the “New Project” name and click \textbf{OK}.

Before we make parameter adjustments, we will look at the output file to determine which layers contribute most to mineralization.
6. Using My Computer or Windows Explorer, navigate to `c:\basins\modelout\agchem` and double click “ag_min2.out.”

7. Scroll down to the “NITR” section and look at the ORGN MINERALIZATION data. Notice that the greatest amount of mineralization occurs in the upper and lower layers:

<table>
<thead>
<tr>
<th>Layer</th>
<th>Nitrogen</th>
<th>Phosphorus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface</td>
<td>0.53</td>
<td>2.23</td>
</tr>
<tr>
<td>Upper Principal</td>
<td>11.39</td>
<td>3.02</td>
</tr>
<tr>
<td>Lower Layer</td>
<td>21.67</td>
<td>3.89</td>
</tr>
<tr>
<td>Active Groundwater</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Total</td>
<td>33.58</td>
<td>9.14</td>
</tr>
</tbody>
</table>

8. Scroll down to the “PHOS” section and look at the ORGP MINERALIZATION data. Notice that, as with nitrogen, the greatest amount of phosphorus mineralization occurs in the lower layer:

<table>
<thead>
<tr>
<th>Layer</th>
<th>Nitrogen</th>
<th>Phosphorus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Upper Principal</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Lower Layer</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Active Groundwater</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Total</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

   **Note:** Scroll to the right to look at the totals for mineralization.

The soil layer distribution of nitrogen and phosphorus mineralization for 1986 is as follows:
9. Close the output file and return to WinHSPF.

10. Click (Input Data Editor).

11. **Double click** PERLND \(\rightarrow\) NITR \(\rightarrow\) NIT-FSTPM.

   **Note:** Notice the “Occurrence” list at the top of this table. Occurrences 1, 2, 3, and 4 correspond to data for the surface, the upper principal, the lower layer, and active groundwater, respectively.

12. Make sure the “Occurrence” is “1.” Change each value of KAM to “0.002.”

   **Note:** KAM is the parameter value for organic nitrogen ammonification (mineralization).

13. Click APPLY.

14. From the “Occurrence” list, select “2.”

15. Change each value of KAM to “0.0004.”

16. Click APPLY.

17. From the “Occurrence” list, select “3.”

18. Change each value of KAM to “0.0004.”

19. Click APPLY.

20. Click OK.

21. Double click NITR to contract the list.

22. Double click PHOS \(\rightarrow\) PHOS-FSTPM.

23. Make sure the “Occurrence” is “1.”

24. Change the value of KMP to “0.02” for PERLND 310.

25. Change the value of KMP to “0.016” for PERLND 311.

   **Note:** KMP is the first order reaction rate for organic phosphorus mineralization.
26. Click APPLY.
27. From the “Occurrence” list, select “2.”
28. Change the value of KMP to “0.0004” for PERLND 310.
29. Change the value of KMP to “0.0001” for PERLND 311.
30. Click APPLY.
31. From the “Occurrence” list, select “3.”
32. Change the value of KMP to “0.001” for PERLND 310.
33. Change the value of KMP to “0.0012” for PERLND 311.
34. Click APPLY.
35. Click OK.
36. Click CLOSE to exit the Input Data Editor.

Next, we will run this scenario, plot the results, and look at the output file to evaluate the impacts of doubling the mineralization rates.

37. Run HSPF and plot the new uptake curves (Scenario = AG_MIN) with the uptake curves you created before doubling the mineralization rates (Scenario = WB_AGCHM). Your plots should look similar to the following:

![Graph showing new uptake curves](image-url)
38. Using My Computer or Internet Explorer, navigate to c:\basins\modelout\agchem and open “wb_agchm2.out.” The new components of nitrogen and phosphorus mineralization for 1986 are as follows:

<table>
<thead>
<tr>
<th>Layer</th>
<th>Nitrogen</th>
<th>Phosphorus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface</td>
<td>1.08</td>
<td>4.36</td>
</tr>
<tr>
<td>Upper Principal</td>
<td>22.59</td>
<td>5.97</td>
</tr>
<tr>
<td>Lower Layer</td>
<td>42.95</td>
<td>7.54</td>
</tr>
<tr>
<td>Active Groundwater</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>66.62</strong></td>
<td><strong>17.87</strong></td>
</tr>
</tbody>
</table>

Compare these values to those generated before doubling the mineralization rates:

<table>
<thead>
<tr>
<th>Layer</th>
<th>Nitrogen</th>
<th>Phosphorus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface</td>
<td>0.53</td>
<td>2.23</td>
</tr>
<tr>
<td>Upper Principal</td>
<td>11.39</td>
<td>3.02</td>
</tr>
<tr>
<td>Lower Layer</td>
<td>21.67</td>
<td>3.89</td>
</tr>
<tr>
<td>Active Groundwater</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>33.58</strong></td>
<td><strong>9.14</strong></td>
</tr>
</tbody>
</table>

Both the nitrogen and phosphorus mineralization values for 1986 were significantly increased. Increasing the mineralization rates makes more inorganic nutrients available to the crop for subsequent plant uptake, and thereby reduces the amount of additional nutrients needed by the crop from fertilization.

39. Close the output file and return to WinHSPF.
Atmospheric Deposition

The most important external sources of nutrients are fertilizer/manure applications and atmospheric deposition.

According to the Maryland Department of Natural Resources, atmospheric deposition is “the process, long recognized by scientists, whereby precipitation (rain, snow, fog), particles, aerosols, and gases move from the atmosphere to the earth's surface. Materials reaching the earth in precipitation or as dry deposition originate from a variety of air pollution sources and can be harmful to the environment and public health. Acidic deposition is the most widely acknowledged form of atmospheric deposition, with well-known effects on lakes, streams, and forests. More recently, atmospheric contributions of nutrients have received increasing attention, particularly as a source of excessive nitrogen entering the Chesapeake Bay. In addition, atmospheric deposition may be a significant source of environmental contaminants such as trace metals and toxic organic compounds” (*Maryland Streams*, 2003).

Input time series can added to HSPF to aid in the simulation of atmospheric deposition of quality constituents. Atmospheric deposition inputs can be specified in two possible ways depending on the form of the available data. If the deposition is in the form of a flux (mass per area per time), then it is considered dry deposition. If the deposition is in the form of a concentration in rainfall, then it is considered wet deposition, and the program automatically combines it with the input rainfall time series to compute the resulting flux. Either type of deposition data can be input as a time series, which covers the entire simulation period, or alternatively, as a set of monthly values that is used for each year of the simulation. The specific atmospheric deposition time series for each operational module (PERLND, IMPLND, RCHRES) are documented in the EXTNL table of the Time Series Catalog for that module (*HSPF Manual*, 2001).

In the following steps, we will increase the multiplication factor for the atmospheric deposition time series, and then plot the uptake curves for nitrogen to assess the effects.

1. In WinHSPF, from the **File** menu, select **Open**. The following window will appear:

2. Click **OK**.

3. Navigate to `c:\basins\modelout\agchem`. Select “wb_agchm.uci” and click **OPEN**.
4. From the **File** menu, select **Save As**.

5. Enter “ag_atdep” as the “New Project” name.

6. Click **(Input Data Editor)**.

7. **Double click** EXT SOURCES. The following window will appear:

8. **Double click** the cell that corresponds to PERLND 310, ANO3, and MultFact. Change the “MultFact” to “1.3.”

9. **Double click** the cell that corresponds to PERLND 310, ANH4, and MultFact. Change the “MultFact” to “1.3.” Your EXT SOURCES block should look like the following:

10. Click **APPLY**.

11. Click **OK**.

**Note:** There is not a phosphorus deposition time series for this project file.
12. Click CLOSE to exit the Input Data Editor.

13. Run HSPF and plot the new nitrogen uptake curves (Scenario = AG_ATDEP) with the original nitrogen uptake curves (Scenario = WB_AGCHM). Your plot should look similar to the following:

![Graph showing nitrogen uptake curves comparison](image)

The plant uptake storage increased slightly with an increase in atmospheric deposition. This is to be expected since there are now more nutrients available for uptake. However, the increase is small because the amount available from atmospheric deposition is small compared to normal agronomic fertilizer/manure applications.

14. Close your plot(s), the “Graph” window, and GenScn.

**Fertilizer Application**

An additional use of these atmospheric deposition time series is the specification of agricultural chemical and fertilizer inputs to the soil. These input time series provide an alternative to the SPEC-ACTIONS block as a means for changing soil storages of chemicals in the AGCHEM sections of the program. For this purpose, "deposition" to the upper soil layer in addition to the surface soil layer is available in PERLND sections NITR, PHOS, and TRACER. Depending on the complexity of the agricultural practices being modeled, the user should decide whether the SPEC-ACTIONS or the time series inputs are simpler to construct (*HSPF Manual*, 2001).

---

1 Section PEST has time series only for the surface layer, since most pesticides are not normally incorporated into the soil as fertilizers are. However, for soil fumigants and similar compounds SPECIAL ACTIONS can be used; this is the preferred method for specifying chemical applications due to the wide range of options available.
Note: Because of time constraints, we will not adjust the fertilizer application rates. If you wish, you can adjust these rates in the SPEC-ACTIONS tables and assess the effects.

D. Additional Exercises

This exercise has been an introduction to AGCHEM. If you have time (and interest), you may want to try the following:

- Use WinHSPF to change tillage practices, fertilizer timing and placement, etc.
- Use the yield-based algorithm for plant uptake and compare with first-order rates.
- Convert the forest segment to the more detailed AGCHEM nitrogen cycling algorithms, which include many more parameters and processes (e.g., above and below ground plant nitrogen, litter layer compartment, return of plant residues to the soil, etc.).

References:
